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DescriptionThe Autodesk 3ds Max 2021: Modeling Essentials, 3rd Edition textbook walks you
through every step of creating 3D models with 3ds Max 2021. This guide is perfect for both
novices and those moving from other software to 3ds Max. This book will help you to get started
with modeling in 3ds Max, you will learn important concepts and techniques about 3D modeling
which you can utilize to create hard-surfaced objects for your projects. You will also learn about
managing external design data in 3ds Max 2021.Using a structured and pragmatic approach,
this guide begins with the basics of modeling, then builds on this knowledge using practical
examples to enhance your modeling skills. Each unit builds on the knowledge gained in the
previous unit, showing you all the essentials of modeling with 3ds Max 2021. As you go from
hands-on exercise to hands-on exercise, you’ll develop a strong arsenal of skills that combined
will form a complete end to end process to create high-quality models using 3ds Max 2021.This
book shares tips, tricks, notes, and cautions throughout, which will help you become a better
3ds Max artist and you will be able to speed up your workflow. This book is aimed to be a solid
teaching resource for learning 3ds Max. It avoids any jargon and explains concepts and
techniques in an easy-to-understand manner. The first page of every unit summarizes the topics
that will be covered in the unit. Hands-on exercises in this book instruct users how things can be
done in 3ds Max step-by-step.Key Features• Covers 3ds Max’s user interface, navigation, tools,
functions, and commands.• Explains the polygon, subdivision, and spline modeling techniques.•
Covers all modifiers.• Explains how to manage external design data.• Detailed coverage of tools
and features.• Features 34 hands-on exercises – complete with before and after files.• Features
40+ practice activities to test the knowledge gained.• Additional guidance is provided in the form
of tips, notes, and cautions.• Important terms are in boldface so that you never miss them.• The
content under “What just happened?” heading explains the working of the instructions.• The
content under “What next?” heading tells you about the procedure you will follow after
completing a step(s).• Tech support from the author.• Access to each exercise’s initial and final
states along with the resources used in hands-on exercises.• Quiz to assess knowledge.• Bonus
hands-on exercises.• Includes a PDF file that contains the color images of the screenshots/
illustrations used in the textbook. These color images will help you in the learning process. This
PDF file is included with the resources.Brief Table of ContentsThis book is divided into the
following units:• Unit 1: Introduction to 3ds Max -I• Unit 2: Introduction to 3ds Max -II• Unit 3:
Geometric Primitives and Architectural Objects• Unit 4: Polygon Modeling• Unit 5: Graphite
Modeling Tools• Unit 6: Spline Modeling• Unit 7: Modifiers• Unit 8: External Design Data• Unit 9:
Bonus Hands-on ExercisesFor more info, visit PADEXI ACADEMY'S website.
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3ds Max 2021: Modeling Essentials, 3rd Edition textbook walks you through every step of
creating 3D models with 3ds Max 2021. This guide is perfect for both novices and those moving
from other software to 3ds Max. This book will help you to get started with modeling in 3ds Max,
you will learn important concepts and techniques about 3D modeling which you can utilize to



create hard-surfaced objects for your projects. You will also learn about managing external
design data in 3ds Max 2021.Using a structured and pragmatic approach, this guide begins with
the basics of modeling, then builds on this knowledge using practical examples to enhance your
modeling skills. Each unit builds on the knowledge gained in the previous unit, showing you all
the essentials of modeling with 3ds Max 2021. As you go from hands-on exercise to hands-on
exercise, you’ll develop a strong arsenal of skills that combined will form a complete end to end
process to create high-quality models using 3ds Max 2021.This book shares tips, tricks, notes,
and cautions throughout, which will help you become a better 3ds Max artist and you will be able
to speed up your workflow. This book is aimed to be a solid teaching resource for learning 3ds
Max. It avoids any jargon and explains concepts and techniques in an easy-to-understand
manner. The first page of every unit summarizes the topics that will be covered in the unit.
Hands-on exercises in this book instruct users how things can be done in 3ds Max step-by-
step.Practicing is one of the best ways to improve skills. This book contains practice activities
which you are highly encouraged to complete and gain confidence for real-world projects. By
completing these activities, you will be able to master the powerful capabilities of 3ds Max. By
the time you’re done, you’ll be ready to model any scene in 3ds Max.If you buy this book, you’ll
also get access to all 3ds Max files, texture files, and any other resource used in the book. You
are free to use these resources in your own projects personal or commercial. These working files
allow you to follow along with the author throughout the units.What are the key features of the
book?Covers 3ds Max’s user interface, navigation, tools, functions, and commands.Explains the
polygon, subdivision, and spline modeling techniques.Covers all modifiers.Explains how to
manage external design data.Detailed coverage of tools and features.Features 34 hands-on
exercises – complete with before and after files.Features 40+ practice activities to test the
knowledge gained.Additional guidance is provided in the form of tips, notes, and
cautions.Important terms are in boldface so that you never miss them.The content under “What
just happened?” heading explains the working of the instructions.The content under “What
next?” heading tells you about the procedure you will follow after completing a step(s).Tech
support from the author.Access to each exercise’s initial and final states along with the
resources used in hands-on exercises.Quiz to assess knowledge.Bonus hands-on
exercises.Includes a PDF file that contains the color images of the screenshots/illustrations used
in the textbook. These color images will help you in the learning process. This PDF file is
included with the resources.Who this book is for?Beginners and intermediate users of 3ds
MaxDigital artistsMotion graphics artistsIndie game developersAnd anyone who wants to learn
3ds MaxWhat are the prerequisites?Decent familiarity with computersBefore you start this book,
you should have 3ds Max 2021 installed on your systemYou should have the desire to
learnWillingness to be awesomeWhat you will learn?Polygon, subdivision, and spline modeling
techniquesEdit geometry using modifiersHandle external design dataSpeed up your
workflowCreate cool looking modelsHow this book is structured?This book is divided into the
following units:Unit 1: Introduction to 3ds Max -I, introduces the 3ds Max interface as well as the



tools that allow you to transform objects in the viewport.Unit 2: Introduction to 3ds Max -II, covers
the tools and procedures that will help you immensely during the modeling process. You will
know about various explorers as well as various precision tools that 3ds Max offers.Unit 3:
Geometric Primitives and Architectural Objects, explains the Standard and Extended primitives
and how you can use them to create some basic models. This unit also covers AEC objects.Unit
4: Polygon Modeling, introduces you to the polygon modeling tools, concepts, and techniques.
This chapter talks about polygons components, selection tools, polygons structure tools, and
modeling objects.Unit 5: Graphite Modeling Tools, describes the tools available in the Ribbon
interface and how you can use them to improve your modeling workflow.Unit 6: Spline Modeling,
introduces you to the spline modeling tools, concepts, and techniques.Unit 7: Modifiers, walks
you through the various modifiers available in 3ds Max that you can use to sculpt or edit the
objects without changing its base structure.Unit 8: External Design Data, explains in ways that
you can use the external data with 3ds Max in your design and visualization workflow.Unit 9:
Bonus Hands-on Exercises, contains bonus hands-on exercises.ConventionsIcons Used in This
BookIconDescriptionTip: A tip tells you about an alternate method for a procedure. It also shows
a shortcut, a workaround, or some other kind of helpful information.Note: This icon draws your
attention to a specific point(s) that you may want to commit to the memory.Caution: Pay
particular attention when you see the caution icon in the book. It tells you about possible side-
effects you might encounter when following a particular procedure.What just happened?: This
icon draws your attention to the working of instructions in a hands-on exercise.What next?: This
icon tells you about the procedure you will follow after completing a step(s).This icon indicates
the new command or tool introduced in the book.This icon indicates that an existing command
or tool has been enhanced in the book.Given below are some examples with these icons:Note:
The editable poly objects vs editable mesh objectsThe editable poly object is similar to the edit
mesh object with the only difference is that the edit mesh object comprises of triangular faces
whereas the editable poly object comprises polygons with any number of vertices.Tip: Dragging
a modifier to an objectTo drag a modifier form one object to another object in the scene, select
an object that already has a modifier. To copy a modifier without instancing it, drag the modifier
name from the stack display to the target object in the scene. If you want to create an instance,
Ctrl-drag the modifier’s name.Caution: Preserving the parametric nature of a primitiveWhen you
convert an object to an editable poly object, you lose all of its creation parameters. If you want to
retain the creation parameters, use the Edit Poly modifier.What next?Now, you will create a
sphere and then conform the splines to the sphere.What just happened?Here, you have made a
connection between the drawing file and 3ds Max. If you now make changes in the drawing, the
changes will automatically affect the 3D models in the scene.Important WordsImportant words
such as menu name, tools’ name, name of the dialogs/windows, button names, and so on are in
boldface. For example:In the Create panel, click Geometry, and then choose Standard Primitives
from the drop-down list located below Geometry. In the Object Type rollout, click Tube. Create a
tube in the Top viewport. Place the tube at the origin. Switch to the Modify panel and then in the



Parameters rollout, change Radius 1 to 30, Radius 2 to 50, Height to 15, Height Segments to 1,
Cap Segments to 2, and Sides to 24.Figure NumbersIn theory, figure numbers are in the
following sequence Fig. 1, Fig. 2, and so on. In exercises, the sequence is as follows: Fig. E1,
Fig. E2, and so on. In exercises, the sequence restarts from number E1 for each hands-on
exercise. In the practice activities section, the sequence is as follows: Fig. A1, Fig. A2, and so
on.Naming TerminologyLMB, MMB, and RMBThese acronyms stand for the left, middle, and
right mouse buttons, respectively.ToolIf you click an item in a palette, toolbar, manager, or
window and a command is invoked to create/edit an object or perform some action then that
item is termed as tool. For example: Align tool, Mirror tool, Select and Move tool.Quad
MenusThe right-click menus or quad menus [see Fig. 1] are the contextual menus in 3ds Max
that provide quick access to the commands/functions/tools related to the currently selected
entities.CheckboxA small box [labeled as 1 in Fig. 2] that, when selected by the user, shows that
a particular feature has been enabled or a particular option chosen.ButtonThe term button
[sometimes known as a command button or push button] refers to any graphical control element
[labeled as 2 in Fig. 2] that provides the user a simple way to trigger an event, like searching for a
query, or to interact with dialog boxes, like confirming an action.Dialog Box or DialogAn area on
the screen in which the user is prompted to provide information or select commands. Fig. 2
shows the Array dialog box.SpinnerSpinners [labeled as 3 in Fig. 2] are controllers that you will
touch on the regular basis. They allow you to quickly amend numerical values with ease. To
change the value in a spinner, click the up or down arrow on the right of the spinner. To change
values quickly, click and drag the arrows. You can also type a value directly in the spinner’s
field.Radio ButtonA radio button [labeled as 4 in Fig. 2] is the one in which a set of options, only
one of which can be selected at any time.Drop-downA drop-down [abbreviated drop-down list;
also known as a drop-down menu, drop menu, pull-down list, picklist] is a graphical control
element, similar to a list box, that allows the user to choose one value from a list. Fig. 3 shows
the Workspaces drop-down list.WindowA window is a separate viewing area on a computer
display screen in a system that allows multiple viewing areas as part of a graphical user interface
(GUI). Fig. 4 shows the Reaction Manager window.TrademarksWindows is the registered
trademarks of Microsoft Inc. 3ds Max is the registered trademarks of Autodesk Inc.Access to
Electronic FilesThis book is sold via multiple sales channels. If you don’t have access to the
resources used in this book, you can place a request for the resources by visiting the following
link: http://www.padexi.academy/contact. Fill the form under the Book Resources [Electronic
Files] section and submit your request.Tech SupportAt PADEXI Academy, our technical team is
always ready to take care of your technical queries. If you are facing any problem with the
technical aspect of the textbook, please send an email to the author at the following
address:pradeepmamgain@gmail.comErrataWe have made every effort to ensure the accuracy
of this book and its companion content. If you find any error, please report it to us so that we can
improve the quality of the book. If you find any errata, please report them by visiting the following
link: http://www.padexi.academy/errata.This will help other readers from frustration. Once your



errata is verified, it will appear in the errata section of the book’s online page.THIS UNIT
COVERS:Understanding workspacesNavigating the workspaceCustomizing the
interfaceUnderstanding various UI componentsWorking with the file management
commandsSetting preferences for 3ds MaxWorking with viewportsSetting preferences for the
viewportsCreating objects in the sceneSelecting objectsUsing the navigational gizmosMoving,
rotating, and scaling objectsGetting helpPer-view Preferences, Asset Library, and Game
ExporterUnit 1: Introduction to 3ds Max - IWelcome to the latest version [2021] of 3ds Max. In
any 3D computer graphics application, the first thing you see is the interface. The interface is
where you view and work with your scene. 3ds Max’s interface is intuitive and highly
customizable. You can make changes to the interface and then save multiple 3ds Max User
Interface [UI] settings using the Workspaces feature. You can create multiple workspaces and
switch between them easily.Note: Interface CustomizationBy default, 3ds Max starts with a dark
theme [white text on the dark gray background]. This is good for those digital artists who spend
hours working with 3ds Max, however, the default theme is not good for printing. I have
customized the theme so that the captures appear fine when the book is printed. You can easily
switch between the custom color themes from the Choose initial settings for tool options and UI
layout dialog box. To open this dialog box, choose Custom UI and Default Switcher from the
Customize menu.When you first time open 3ds Max, you will see the Welcome Screen. This
screen hosts a slide show designed to inspire as well as provide new users with some basic
information to get them started.Note: Welcome ScreenIf you don’t want to see the Welcome
Screen next time you open 3ds Max, clear Show this Welcome Screen at startup checkbox
located at the bottom-left corner of the Welcome Screen. You can bring back the screen anytime
by choosing Welcome Screen from the Help menu.Close Welcome Screen to view the default UI
of 3ds Max [refer Fig. 1]. Notice, I have marked different components of the UI with letters to
make the learning process easier. In 3ds Max, commands and tools are arranged in groups so
that you can find them easily. For example, all viewport navigation tools are grouped in the
bottom-right corner of the interface [marked as I in Fig. 1].The 3ds Max interface can be divided
into 11 sections. I have marked those sections in Fig. 1. Table 1 summarizes the letters and the
sections of the UI they represent.Table 1: 3ds Max interface
overviewItemDescriptionAMenubarThe menubar provides access to command and tools.BMain
toolbarThis toolbar consists of many commonly used tools.CRibbonRibbon contains many tools
for modeling and painting in the scene. Also, here you will find tools for adding people to
populate a scene.DScene ExplorerThe Scene Explorer lets you view, sort, filter, and select
objects in a scene. You can also use it to rename, delete, hide, and freeze objects. It is also used
to create and amend object hierarchies.EStatus BarThe Status Bar contains the prompt and
status information about the scene. The Coordinate Transform Type-In boxes in the Status Bar
let you transform the objects manually.FViewport LabelMenusThese menus let you change the
shading style for the viewport. They also contain other viewport related commands and
features.GTime SliderAllows you to navigate along the timeline.HCreate and PlayBack



AnimationThese controls affect the animation. This area also contains buttons to playback
animation in the viewports.IViewportNavigationThese buttons allow you to navigate your scene
[Active Viewport].JViewportsViewports let you view your scene from multiple angles. They also
allow you to preview lighting, shading, shadows, and other effects.KCommand panelThe
Command panel is the nerve center of 3ds Max. It contains six panels that you can use to create
and modify objects in 3ds Max.There are some other elements of the interface that are not
visible in the default UI. These elements appear when you run a command from the Main toolbar
or menu, or choose an option from the RMB click menu. Here’s is the quick rundown to those
elements:• Toolbars: There are quite a few toolbars available in 3ds Max. To access these
toolbars, RMB click on an empty gray area on the Main toolbar to open a context menu [see Fig.
2] containing the options for invoking the toolbars. When I chose MassFx Toolbar from the
context menu, the Mass FX Toolbar appeared [see Fig. 3].• Quad Menus: Whenever you RMB
click in an active viewport [except on a viewport label], 3ds Max opens a Quad menu at the
location of the mouse pointer. The Quad menu can display up to four quadrants [see Fig. 4] with
various commands and allows you to work efficiently because the commands in the menu are
context-sensitive. The Quad menu is the quickest way to find commands. Fig. 4 shows a Quad
menu that appeared when I RMB clicked on an Editable Poly object in the viewport.• Caddy
Controls: A caddy control in 3ds Max can be described as “in canvas” interface that comprises a
dynamic label and an array of buttons superimposed over a viewport. You can use the standard
mouse operations such as clicking and dragging to change the values in the spinners. The
changes you made are immediately updated in the viewport. The Chamfer caddy control that is
shown in Fig. 5 appeared when I selected edges of a box and then clicked Chamfer’s settings
button in the Command panel.• Dialogs, Windows, and Editors: Some of the commands in 3ds
Max open dialog boxes, editors, and windows. Some of these elements have menu bars and
toolbars. Fig. 6 shows the Slate Material Editor. You can use the M hotkey to open this
editor.Note: SpinnersSpinners are found everywhere in 3ds Max [I have marked U and V
spinners with a black rectangle in Fig. 7]. Spinners are controllers that you will touch on a regular
basis. They allow you to quickly amend numerical values with ease. To change the value in a
spinner, click the up or down arrow on the right of the spinner. To change values quickly, click
and drag the arrows. You can also type a value directly in the spinner’s field.Tip: Fast and slow
scroll rate in a spinnerPress and hold Alt and then click-drag the spinner’s up or down arrow for a
slower numerical scroll rate. Hold Ctrl for the faster scroll rate. RMB click on a spinner to set it to
its default value.Note: Numerical Expression EvaluatorIf the type cursor is located inside a
spinner and you press Ctrl+N, the Numerical Expression Evaluator appears [see Fig. 8]. This
evaluator lets you calculate the value for the spinner using an expression. For example, if you
type 30+50 in this evaluator’s field and click Paste, 80 appears in the associated spinner.Note:
Modeless dialogs, controls, windows, and editorsQuite a few dialog boxes in 3ds Max are
modeless meaning the dialog box doesn’t need to be closed in order to work on other elements
of the interface. A good example of a modeless dialog box is the Slate Material Editor. You can



minimize the editor and continue working on the scene. Other modeless dialog boxes that you
would frequently use are Transform Type-In dialog boxes, Caddy controls, Render Scene dialog
box, and so on.Tip: Toggling the visibility of all open dialog boxesYou can toggle the visibility of
all open dialog boxes by using the Ctrl+~ hotkeys.UI Components You can easily customize the
workspace by floating and docking the window, panels, toolbars, and so on. You can dock any
element of the interface that has a handle. A handle can be at the left or top of the element [see
Fig. 9]. To float an element, click-drag the handle. As you move the handle around, target dock
locations will be highlighted in blue. Drop the element on the blue highlight if you want to dock
element in the interface.Caution: ToolbarsToolbars can be docked only on the outer edge of the
interface.Caution: Resize ElementsWhen you move around elements, some of the elements
may not automatically resize. In such cases, you will have to resize elements manually.Note:
Docking floating windowsYou can dock a floating window by RMB clicking on the title bar or
handle of the window and then choosing Dock from the context menu. Now, you can select an
available location from the menu displayed. Once you are happy with the arrangement of the
elements in the interface, you can save the arrangement using the Workspaces drop-down. The
options in the Workspaces drop-down list allow you to switch quickly among different interface
setups. This drop-down is available on the top-right corner of the interface.A workspace is
defined as the interface setup including any combination of toolbars, menus and quad menus,
viewport layout presets, the ribbon, hotkeys, and the workspace Scene Explorer. You can define
any number of workspaces as you want using the Manage Workspaces window. To open this
window, select Manage Workspaces from the Workspaces drop-down. The Reset To Default
State option in this drop-down is used to load the saved definition of the workspace based on
the active workspace properties.Here’s the quick rundown to the available options:Alt Menu and
Toolbar: It uses the alternate menu system. In this setup, the Scene Explorer is docked below
the Command panel. The Main toolbar is modular and docked to the left.Design Standard: This
setup in ideal for novice users. The commonly used features and learning resources are on the
Ribbon.Main Toolbar - modular: In this setup, the viewport layout tab is removed and the Main
toolbar is modular.Modular - mini: In this setup, the viewport layout tab is removed and the Main
toolbar is modular with several groups of tools hidden.Default: The default layout on
startup.Note: Menu systemAll included workspaces in 3ds Max use the default menu system
and horizontal ribbon except the Alt Menu and Toolbar which uses an alternate menu system
and docks several toolbars to the left of the viewports.Different 3ds Max UI components are
discussed next.Caption BarThe Caption bar is another name for the Title bar. It is the topmost
element in the 3ds Max UI. The Title bar displays the name of the current 3ds Max
file.MenubarThe menubar is located below the Caption bar. The menus in the menubar gives
you access to various commands and tools.What is the function of the Reset command?This
command clears all data as well as resets 3ds Max settings such as viewport configuration,
snap settings, Material Editor, background image, and so on. If you have done some
customization during the current session of the 3ds Max, and you execute the Reset command,



all startup defaults will be restored according to the setting stored in the maxstrat.max file. The
Reset command is available in the File menu.How can I use maxstart.max?You can use this file
to make the changes you would like to see at the startup. Start 3ds Max and make the
adjustments. Then, save the file in the scenes folder with the name maxstrat.max.Note:
TemplatesIf you reset the scene, it will also affect the template that you had used to open the
scene. The template will be reset back to its default settings.How can I change the undo levels?
You can change it from the Preferences dialog box. By default, 3ds Max allows only 20 levels for
the undo operations. To change it, choose Preferences from the Customize menu. In the General
panel of the dialog box, you can set Levels from the Scene Undo group.What is the use of the
Preferences dialog box?The Preferences dialog box contains options that 3ds Max offers for its
operations. 3ds Max behaves according to the options you set in the Preferences dialog box.
You have just seen an example of how you can change the undo levels. If you increase the
number of levels, you force 3ds Max to obey that setting. The Preferences dialog box comprises
many panels with many options that you can use.Tip: Preferences dialog boxYou can also open
the Preferences dialog box by selecting Preferences from the File menu.Can I undo all
commands in 3ds Max?No. You cannot undo some commands such as saving a file or using the
Collapse utility. If you know an action cannot be undone, first hold your scene by choosing Hold
from the Edit menu [Hotkeys: Ctrl+H]. When you want to recall, choose Fetch from the Edit menu
[Hotkeys: Alt+Ctrl+F].Why do I need a project folder?When you work on a project, you have to
deal with many scenes, texture files, third party data, rendering, material libraries, and so on. If
you don’t organize the data for the project, it would be very difficult for you to manage the assets
for the project. The project folder allows you to organize all your files in a folder for a particular
project. You can set a project by using the options available in the File > Project menu.The menu
system follows the standard Windows conventions. When you click on a menu item on the menu
bar, a pulldown menu appears. You can also open a pulldown menu by pressing the associated
menu hotkey with Alt. When you hold Alt, the hotkey is denoted by an underline in the name of
the menu. For example, if you want to open the Edit menu, press Alt+E. Similarly, for the
Customize menu, press Alt+U.If a hotkey is available for a command, it will appear in the menu
next to the command name. You can use these hotkeys to execute the command without
invoking the menu. For example, to select all objects in a scene, you can press Ctrl+A. To
execute this command from the menubar, you have to choose Select All from the Edit menu.Not
all the commands are available all the time, some commands are context-sensitive. If a black
triangle appears [for example, the Selection Region command in the Edit menu] on the next to a
menu command, it indicates that a sub-menu exists. Place the mouse pointer on the command
to view the sub-menu.Viewports In 3ds Max, you will be doing most of the work in the viewports.
Viewports are openings into 3D space you work. A viewport represents 3D space using the
Cartesian coordinates system. The coordinates are expressed using three numbers such as [10,
10, 20]. These numbers represent points in 3D space. The origin is always at [0, 0, 0].By default,
3ds Max displays a four viewport arrangement: Top, Front, Left, and Perspective. The Top, Front,



and Left are known as orthographic views. 3ds Max provides many options to change the
viewport as well as the layout. Using multiple viewports can help you visualize the scene
better.What is an Orthographic View?Most of the 3D designs created using the computer rely on
the 2D representation of the designs. Some examples of the 2D representations are maps,
elevations, and plans. Even to create a character model, you first design it on paper [front, side,
and back views] [see Fig. 10] and then create a 3D model using these designs.Note:Blueprint
Courtesy:In layman’s terms, you can think of the orthographic views as flat, or straight on. The
orthographic views are two-dimensional views. Each dimension is defined by two world
coordinate axes. The combination of these two axes produces three sets of orthographic views:
Top and Bottom, Front and Back, and Left and Right. Fig. 11 shows a model in three
orthographic views [Top, Right, and Left] and the Perspective view.You can change a viewport to
various orthographic views using the options available in the Point-Of-View (POV) viewport label
menu. The Perspective view on the other hand closely resembles the human view. In 3ds Max,
there are three ways to create a perspective view: Perspective view, camera view, and light
view.Can you tell me a little bit more about Viewport Label menus and how can I change a
viewport to the orthographic views?Notice on the top-left corner of a viewport, there are four
labels. Fig. 12 shows labels on the Perspective viewport. Each label is clickable [click or RMB
click]. When you click on any of the labels, a popup menu appears.The leftmost menu is the
General Viewport label menu [marked as 1], in the middle is the Point-Of-View [POV] viewport
label menu [marked as 2], and on the right is Lights and Shadows viewport label menu [marked
as 3]. The rightmost menu is the Shading viewport label menu [marked as 4]. The General
Viewport label menu comprises of options for overall viewport display or activation. It also gives
you access to the Viewport Configuration dialog box. The POV Viewport label menu provides
options mainly for changing the viewports. To switch a viewport, for example, to change the Top
viewport into the Bottom viewport, make sure the Top viewport is active and then click or RMB
click on the POV Viewport label menu. Now, choose Bottom from the menu. You can also use
the hotkey B. Table 2 summarizes the hotkeys that you can use to change the viewports.Table 2:
The hotkeys for switching the
viewportsViewHotkeyTopTBottomBFrontFLeftLCameraCOrthographicUPerspectivePThe
Shading Viewport menu lets you control how objects are displayed in the viewport. I will discuss
the options in this menu later in the unit. The Lighting and Shadows option lets you adjust the
behavior of the lights and shadows in the viewport. You can also adjust quality settings from this
menu.What is an active viewport?An active viewport is where all actions take place in 3ds Max.
One viewport is always active in 3ds Max marked with a highlighted border. To switch the active
viewport, you can use any of the three mouse buttons. It is recommended that you use the MMB
for making a viewport active as LMB and RMB clicks are also associated with other commands
in 3ds Max.When viewports are not maximized, you can press the Windows key and Shift on the
keyboard to cycle the active viewport. When one of the views is maximized, pressing Windows
key and Shift displays the available viewports [see Fig. 13] and then you can press Shift



repeatedly with the Windows key held down to cycle among viewports. When you release the
keys, the chosen viewport becomes the maximized viewport.How can I change the viewport
configuration like the one shown in Fig. 11?The Viewport Layouts bar lets you quickly
switch among different types of viewport layouts. This bar generally docked on the left of the
viewports [see Fig. 14]. If it is not visible, RMB click on the empty area of the Main toolbar and
then choose Viewport Layout Tabs. To change the layout, click on the arrow on the bar to open a
flyout and then click on the desired layout to make it active.You can also change the layout using
the General Viewport label menu. Click on the label and then choose Configure Viewports. The
Viewport Configuration dialog box appears [refer to Fig. 15]. Select the Layout panel and then
choose the desired layout. Now, click OK to accept the changes.I can see a grid in each
viewport, how can I use it?The grid you see in each viewport is one of the three planes [along
the X, Y, and Z axes] that intersects at the right angles to each other at a common point called
origin [X=0, Y=0, and Z=0]. The three planes based on the world coordinate axes are called the
home grid. To help you easily position objects on the grid, one plane of the home grid is visible in
each viewport. The grid acts as a construction plane when you create objects on it.Tip: Turning
off the gridYou can turn off the grid in the active viewport by pressing the G hotkey.Floating
Viewports 3ds Max allows you to work in the floating viewport window. This floating window
works just like the regular viewport and it is fully customizable. The floating viewport is not
dockable, however, you can move it to another monitor if you have multiple monitors.Caution:
Floating viewportIf you are using the legacy Direct3D display driver, you can not float a
viewport.You can open up to three floating viewports. To open a floating viewport, click or RMB
click on the General Viewport label menu and then choose Float Viewport > Floating Viewport 1,
Floating Viewport 2, or Floating Viewport 3.Command PanelThe Command panel is the nerve
center of 3ds Max. It comprises of six panels that give you access to most of the modeling tools,
animation features, display choices, and utilities. Table 3 summarizes the panels in the
Command panel.Table 3: Different panels in the Command
panelPanelDescriptionCreateContains options for creating objects such as geometry, lights,
cameras, and so on.ModifyContains options for editing objects as well as for applying modifiers
to the objects.HierarchyContains options for managing links in the hierarchy, joints, and inverse
kinematics.MotionContains options for animation controllers and trajectories.DisplayContains
options that let you hide/unhide objects. It also contains display options.UtilitiesContains
different utility programs.RolloutsMost of the parameters in the Command panel live inside
rollouts. A rollout is a group of parameters, a section of the Command panel that shows
parameters of the selected object. You can collapse the rollouts. When you collapse them, only
the title bar of the rollout appears. Fig. 16 shows the Parameters rollout of the Box primitive in the
Modify panel of the Command panel.Once you create a box in the viewport, you can modify its
parameters such as Length and Width using the Parameters rollout. Each rollout has a title bar
that you can click to collapse or expand the rollout. You can also change the default position of
the rollout by dragging the dots located on the right of the title and dropping on another place



when a blue line appears [see Fig. 17].By default, the rollout occupies a single column space in
UI. However, you can increase the numbers of columns by dragging the leftmost edge of the
Command panel. You can create as many columns as you want [see Fig. 17] as long as the
screen real state is available. Multiple columns are helpful when you are working with an object
with which many rollouts are associated.If you RMB click on a rollout [on the empty gray area], a
context menu appears [see Fig. 18]. This menu allows you to open or close all rollouts at once,
or close the rollout on which you RMB clicked. In the bottom section of the context menu, you
will see a list of rollouts available for the selected object. No tick appears for the collapsed
rollouts.If you have changed the order of the rollouts, you can reset it by choosing Reset Rollout
Order from the bottom of the menu [see Fig. 19]. If you have expanded the Command panel to
more than one column and you RMB click on a rollout, only those rollouts appear on the context
menu that are in the column.Tip: The default value for the spinnersThe nature of the spinners in
3ds Max is persistence meaning that value specified for the spinners remains set for the current
spinners. For example, if you created a Sphere primitive with 64 segments. When you create the
next sphere, the value 64 will be the default for it. To reset spinners to their default values,
choose Reset from the File menu.Main Toolbar The Main toolbar comprises commonly used
tools. Table 4 summarizes the tools available in the Main toolbar.Table 4: The Main toolbar
interface overviewItemIconDescriptionUndo/Redo Undo reverses the last command. Redo
reverses the last undo command.Select and LinkDefines the hierarchical relationship [links]
between two objects.Unlink SelectionRemoves the hierarchical relationship between two
objects.Bind to SpaceWarpAttaches the current selection to a space warp or vice
versa.SelectionFilter ListLimits the selection to specific types and combinations of
objects.Select ObjectSelects objects and sub-objects.Hotkey: Q.Select by NameAllows you to
select specific objects from a list of objects using the Select From Scene dialog box. Hotkey:
H.Selection RegionFlyoutAllows you to select objects within a region using different methods.
You can create different marquee shapes using the options available in this flyout.Window/
CrossingSelection ToggleSwitches between the window and crossing methods for selection.
Hotkeys: Shift+O.Select and MoveSelects and moves objects. Hotkey: W.Select and
RotateSelects and rotates objects. Hotkey: E.Select and ScaleSelects and scales objects.
Hotkey: R to cycle.Select and PlaceFlyoutPosition an object accurately on the surface of another
object.Reference CoordinateSystemSpecifies the coordinate system used for a transformation
(Move, Rotate, and Scale).Use Center FlyoutSpecifies geometric centers for the scale and
rotate transformations.Select and ManipulateSelects objects and allows editing of the
parameters for certain objects, modifiers, and controllers by dragging "manipulators" in the
viewports.KeyboardShortcutOverride ToggleAllows you to toggle between using only the "Main
User Interface" hotkeys or using both the main hotkeys and hotkeys for groups such as Edit/
Editable Mesh, Track View, NURBS, and so on.2D Snap,2.5D Snap,3D SnapThese options
specify the snap types.Hotkey: S to cycle.Angle Snap ToggleEnables angle increment snap for
rotation. It allows you to snap rotations to certain angles. Hotkey: A.Percent SnapToggleToggles



increment scaling of objects by the specified percentage.Hotkeys: Shift+Ctrl+P.Spinner
SnapToggleSets the single-click increment or the decrement value for all of the spinners in 3ds
Max.ManageSelection SetsDisplays the Named Selections Sets dialog box, letting you manage
named selection sets of sub-objectsNamed SelectionSetsAllows you to name a selection set
and recall the selection for later use.MirrorEnables you to move and clone selected objects while
reflecting their orientation.Align FlyoutGives you access to six different tools for alignment.
Hotkeys: Align [Alt+A] and Normal Align [Alt+N].Toggle SceneExplorerToggles the Scene
Explorer.Toggle LayerExplorerToggles the Layer Explorer.Show RibbonExpands or collapses
the Ribbon.Curve EditorOpens the Track View - Curve Editor.SchematicViewOpens the
Schematic View window.Material EditorflyoutOpens the material editor that provides functions to
create and edit materials and maps. Hotkey: MRender SetupOpens the Render Setup
window.Hotkey: F10.Rendered FrameWindowOpens the Rendered Frame Window that displays
the rendered output.RenderProductionRenders the scene using the current production render
settings without opening the Render Setup window. Hotkeys: Shift+Q, Shift+F9Render in
theCloudOpens a dialog box for setting up cloud rendering with Autodesk A360.Open Autodesk
A360 GalleryOpens the default browser that displays the home page of the Autodesk A360
image library.Set ActiveProjectOpens the Select Active Project dialog box. It allows you to set a
folder to be the root of the current project.Create EmptyProjectOpens the Choose a folder dialog
box. It allows you to create a new project with no structure or hierarchy by selecting a single root
directory.Create DefaultProjectCreates a new project with the default folder structure using the
Choose a Folder dialog box.Crate fromCurrentCreates a new project based on the folder
structure of the current project using the Choose a Folder dialog box.Main Toolbar FlyoutsYou
might have noticed a small triangle on the lower-right corner of some icons on the Main toolbar.
Click and hold on such icons to expand a flyout with additional icons. Fig. 20 shows the
Selection Region flyout.RibbonThe Ribbon [see Fig. 21], is available below the Main toolbar. The
Ribbon appears in the collapsed state by default. To expand it, double-click on it. You can toggle
the display of the Ribbon by clicking Show Ribbon in the Main toolbar.It contains many tabs. The
content in these tabs is depended on the context. The items displayed may vary according to the
selected sub-objects. I will cover the Ribbon in later units. Most of the tools are only visible in the
Ribbon when you are editing a poly object.Animation and Time ControlsThe animation controls
are found on the left of the Viewport Navigation controls [see Fig. 22]. Two other controls that are
vital to animation are Time Slider and Track Bar [see Fig. 23]. These controls are available below
the viewports. The Time Slider works with the Track Bar to allow you to view and edit animation.
The sliders show the current frame and the total number of frames in the range. The Track Bar
shows the frame numbers and allows you to move, copy, and delete keys.Table 5 summarizes
the animation controls.Table 5: The animation controlsItemIconDescriptionAuto KeySet KeySet
KeysAuto Key toggles the automatic key mode.Hotkey: NSet Keys allows you to create keys for
individual tracks of the selected object using a combination of the Set Keys button and Key
Filters.Selection ListProvides quick access to Named Selection Sets and track sets.Default In/



OutTangents for New KeysThis flyout provides a quick way to set a default tangent type for new
animation keys.Key FiltersOpens the Set Key Filters dialog box where you can specify the tracks
on which keys are created.Go To StartMoves the time slider to the first frame of the active time
segment. Hotkey: HomePrevious Frame/KeyMoves the time slider back one frame.Hotkey: ,Play
AnimationStop Animation The Play Animation button plays the animation in the active viewport.
You can stop the playback by clicking on the button again. Hotkey: /Next Frame/KeyMoves the
time slider ahead one frame.Hotkey: .Go To EndMoves the time slider to the last frame of the
active time segment. Hotkey: EndCurrent Frame(Go To Frame)Displays the number or time of
the current frame, indicating the position of the time slider.Key ModeAllows you to jump directly
between keyframes in your animation.Time ConfigurationOpens the Time Configuration dialog
box that allows you to specify the settings for the animation.Viewport Navigational ControlsThe
Viewport Navigation Controls are located at the right end of the Status Bar [see Fig. 24]. The
controls in the Viewport Navigation Controls depend on the type of viewport [Perspective,
orthographic, camera, or light] active. Some of the buttons have a little black triangle at the right-
bottom corner. The triangle indicates that there are some hidden buttons that exist. To view
them, press and hold LMB on the button. When a button is active, it is highlighted. To deactivate
it, press ESC, choose another tool, or RMB click in a viewport.Table 6 shows the controls
available for all viewports. Table 7 shows the controls available for the Perspective and
orthographic views. Table 8 shows the controls available for the camera views. Table 9 shows the
controls available for the light views.Table 6: The viewport navigational controls available for all
viewportsItemIconDescriptionZoom Extents AllZoom Extents All SelectedAllow you to zoom
selected objects or all objects to their extent in the viewport.Maximize Viewport ToggleIt
switches any active viewport between its normal size and full-screen size.Hotkeys: Alt+W.Table
7: The viewport navigational controls available for Perspective and orthographic
viewsItemIconDescriptionZoomAllows you to change the magnification by dragging in a
Perspective or orthographic viewport.Hotkeys: Alt+Z. You can also use the bracket keys,
[ and ].Zoom AllAllows you to adjust view magnification in all perspective and orthographic
viewports at the same time.Zoom Extents,Zoom ExtentsSelectedZoom Extents centers all
visible objects in an active perspective or orthographic viewport until it fills the viewport. Hotkeys:
Ctrl+Alt+Z. Zoom Extents Selected centers a selected object or set of objects. Hotkey:Z.Field-of-
ViewField-of-View adjusts the area of the scene that is visible in a viewport. It's only available in
the Perspective viewport. Hotkeys: Ctrl+W. Zoom Region magnifies a rectangular area you drag
within a viewport.Pan ViewPan View moves the view parallel to the current viewport plane.
Hotkeys: Ctrl+P.Walk ThroughAllows you to move through a viewport by pressing arrow keys.
Hotkey: Up Arrow.2D Pan Zoom ModeIn this mode, you can pan or zoom a viewport without
changing the rendering frame. It is especially useful when you are using a Perspective or
Camera viewport in conjunction with Perspective Match.OrbitOrbit SelectedOrbit Sub-
ObjectOrbit rotates the viewport and uses the view center as the center of rotation. Hotkeys: Ctrl
+R. Orbit Selected uses the center of the current selection as the center of rotation. Orbit Sub-



object uses the center of the current sub-object selection as the center of rotation.Table 8: The
viewport navigational controls available for camera viewsItemIconDescriptionDolly Camera,
Target,or BothThis flyout replaces the Zoom button when the Camera viewport is active. Use
these tools to move the camera and/or its target along the camera main axis.PerspectiveIt
performs a combination of FOV and dolly for target cameras and free cameras.Roll
CameraRotates a free camera around its local z-axis.Field-of-ViewAdjusts the amount of the
scene that is visible in a viewportTruck CameraMoves the camera parallel to the view
plane.Walk ThroughAllows you to move through a viewport by pressing a set of shortcut
keys.Orbit/Pan CameraOrbit Camera rotates a camera about the target. Pan Camera rotates the
target about the camera.Table 9: The viewport navigational controls available for light
viewsItemIconDescriptionDolly Light, Target, orBothMoves the light or its target or both along the
light’s main axis, toward, or away from what the light is pointing at.Light HotspotAllows you to
adjust the angle of a light's hotspot.Roll LightRoll Light rotates the light about its line of sight (the
light's local Z-axis).Light FalloffAdjusts the angle of a light's falloff.Truck LightMoves a target light
and its target parallel to the light view and moves a free light in its XY plane.Orbit/Pan
LightRotates a light about the target. Pan Light rotates the target about the light.Interaction Mode
PreferencesIf you are an Autodesk Maya user then it’s good news for you that you can change
the interaction mode to Maya. The Interaction Mode panel of the Preferences dialog box [see
Fig. 25] allows you to set the mouse and keyboard shortcuts according to 3ds Max or
Maya.When you set Interaction Mode to Maya, most of the hotkeys and mouse operations
behave as they do in Autodesk Maya. Here’s the list:Pressing Spacebar maximizes the viewport
that is beneath the mouse pointer.Shift+Click adds or removes from the selection. Ctrl+Click
removes from the selection.The Orbit tools are not available in the orthographic views.Alt+Home
switches to the default Perspective view.Alt+LMB drag rotates the view. Alt+MMB drag pans the
view. Alt+RMB drag zooms in or out in the view.Table 10 shows a comparison between the 3ds
Max and Maya hotkeys.Table 10: The comparison between 3ds Max and Maya
hotkeysFunction3ds MaxMayaMaximize Viewport ToggleAlt+WSpacebarZoom Extents
SelectedZFZoom Extents AllShift+Ctrl+ZAUndo Viewport OperationShift+ZAlt+ZRedo Viewport
OperationShift+YAlt+YPlay Animation/Alt+VSet KeyKSGroupNoneCtrl+GEditable Poly > Repeat
LastOperation;GGetting Around in 3ds MaxIn the previous section, you have seen various
components of 3ds Max’s UI. Don’t get hung up on all the buttons, commands, menus, and
options. It was a quick tour of the interface to get your feet wet. The more time you spent on Unit
1 and Unit 2, the easier it will be for you to understand the rest of the units.Creating Objects in
the SceneYou can’t do much with a blank scene. You need some objects in the scene in order to
work on them. 3ds Max offers a wide range of standard objects. Let’s start by creating some
geometry in the scene.Start 3ds Max, if not already running. Choose Reset from the File menu
to open the 3ds Max message box. Click Yes to reset the scene. Notice there are several panels
in the Command panel: Create, Modify, Hierarchy, Motion, Display, and Utilities. Position the
mouse pointer on a panel’s icon; a tooltip appears showing the name of the panel. The Create



panel comprises of the following basic categories: Geometry, Shapes, Lights, Cameras,
Helpers, Space Warps, and Systems. Each category is farther divided into sub-
categories.Notice in [see Fig. 26] the Create panel [marked as 1], the Geometry button [marked
as 2] is active. Below that button, you will see a drop-down list [marked as 3] that contains the
Geometry sub-categories 3ds Max offers. Notice the Standard Primitives is selected by default
in the drop-down list.Below the drop-down list, there is the Object Type rollout [marked as 4].
There are eleven buttons in this rollout. When you click on one of the buttons, the corresponding
tool gets active and then you can create the corresponding object in the scene interactively
using the mouse or by entering precise values using the keyboard.Let’s create an object from
the Standard Primitive sub-category. Ensure you are in the Command panel > Create panel >
Geometry category > Standard Primitives. Now, click on Box in the Object Type rollout. Notice
four rollouts appears in the Create panel: Name and Color, Creation Method, Keyboard Entry,
and Parameters.The Keyboard Entry rollout is collapsed whereas the other three are in the
expanded state. Expand the Keyboard Entry rollout by clicking on the title bar of the rollout.
Change Length to 50, Width to 50, and Height to 10. Click Create. You need to press Enter or
Tab after typing the values. Congratulations, you have created your first object in 3ds Max [see
Fig. 27].You have not changed the values of the X, Y, and Z parameters in the Keyboard Entry
rollout. As a result, the box is created at the origin of the home grid [0, 0, 0].Also, notice the
name of the object [Box001] in the Name and Color rollout. Every time you create an object, 3ds
Max assigns it a default name. Collapse the Keyboard Entry rollout. In the Parameters rollout,
change Length and Width to 100 each.Notice the box in the viewports resizes as per the new
dimensions you have set for the Length and Width parameters. The change occurs because still
Box001 is active in the Object Type rollout. If you select any other tool, then you would not be
able to modify values from the Create panel.Then, how to change the parameters? Well, once
you select any other tool, you can change values for parameters from the Modify panel [panel
available on the right of the Create panel]. Click the Modify panel [see Fig. 28] and notice the
Parameters rollout appears there. Change Height to 20.Change Length Segs, Width Segs, and
Height Segs to 2 each. Notice the change is reflected on the object in the viewport.Notice the
white brackets around the box in the Perspective viewport. These are selection brackets that
show the bounding box of the object. I am not a big fan of the selection brackets and don’t find
them very useful. Press Shift+J to get rid of the selection brackets. To change values for
parameters of an object from the Parameters rollout, the object must be selected in the viewport.
I will cover selection methods later in the unit.Click the General Viewport label in the Perspective
viewport and choose Configure Viewports from the popup menu. In the Viewport Configuration
dialog box that appears, choose the Layout tab and then click on the layout button highlighted
with white borders in Fig. 29. Now, click OK to change the viewport layout [see Fig. 30].You have
just changed the viewport layout. The Top, Front, and Left viewports are stacked over each other
on the left whereas on the right you will see enlarged Perspective viewport.Note: Viewport
layoutI frequently change viewport layouts as per my needs. In hands-on exercises, if you find a



different viewport layout in captures, this is the place from where you can change it. I have not
written this process in hands-on exercises.MMB click on the Left viewport to make it active.
Press T to change it to the Top viewport. Press L to change it to the Left viewport. As discussed
earlier, the options for changing the viewport are available in the Point-Of-View [POV] viewport
label menu. Now onwards, I will refer Point-Of-View [POV] viewport label menu as the POV
viewport label menu.Tip: Viewports quad menuYou can also change the viewports using the
Viewports quad menu. To invoke this menu, press V. To change a viewport, select the desired
option from the Switch View quadrant of the menu.Notice the text for the Shading Viewport label
reads Default Shading. Click on the Shading Viewport label to display the Shading Viewport
label menu. The options in this menu allow you to define the shading style for the viewport.
Choose Clay from the menu to display the object in the Clay shading mode. The Edged Faces
mode allows you to view object subdivisions in the viewports. Hidden Line hides the faces and
vertices whose normals are pointing away from the viewport. Shadows are unavailable in this
mode.Wireframe Override displays objects in the wireframe mode. The hotkey for toggling the
Wireframe mode is F3. Bounding Box displays the edges of the bounding box of the geometry.
Clay displays geometry in a uniform terracotta color. Fig. 31 shows the teapot in the Hidden Line,
Wireframe, Bounding Box, and Clay modes, respectively. My favorite shading mode for modeling
is Clay with Edged Faces and I have extensively used it in this book. The shortcut to toggle the
Edged Faces mode is F4.
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